ArcReader quick-start tutorial
IN THIS CHAPTER
• Exercise 1: Viewing a map

The best way to learn ArcReader is to try it yourself. This tutorial guides
you through some basic ArcReader skills as you explore a map of Angelus
Oaks, California.

• Exercise 2: Querying a map

Exercise 1 introduces various ways that you can view a map.

• Exercise 3: Printing a map

Exercise 2 shows you how to query a map.

• Exercise 4: Exploring a 3D map

Exercise 3 walks you through printing a map.
Exercise 4 shows you how to view a three-dimensional map.
Each exercise in this tutorial takes between 15 and 20 minutes to complete.
You can either work through the entire tutorial at once or complete each
exercise one at a time.
The data and maps for this tutorial can be found on the ArcReader product
page on the ESRI Web site located at http://www.esri.com.
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Exercise 1: Viewing a map

1

In this exercise, you will open and explore a published map
with ArcReader. You will also use ArcReader to query data
on the map.
Starting ArcReader
1. Click Start on the Windows taskbar.
2. Click Programs, point to ArcGIS, and click ArcReader.
ArcReader opens.

2

2. Click the Look in drop-down arrow and navigate to the
map folder on the local drive where you installed the
tutorial.

2

1
Opening an existing published map
1. Click File and click Open.

3. Click Angelus Oaks Recreation.pmf and click Open.
ArcReader opens the map.
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ArcReader can open published map files (.pmf) that have
been created in ArcMap and ArcGlobe with the ArcGIS
Publisher extension. These published maps do not actually
store the data shown on the map but rather reference the
data, which may be stored on a local disk, another
computer, or the Internet. The map document stores map
elements, such as titles, scale bars, and north arrows.
Table of
contents

Data toolbar

Map display

This is an example of a .pmf—the Angelus Oaks Recreation.pmf.

A data frame is a frame on the map that groups the layers
you want to display together.
This map contains four data frames. Most of the tutorial
exercises will use the Angelus Oaks Recreation Area data
frame. The other three data frames will be discussed later
in this tutorial. The layers contained in the Angelus Oaks
Recreation Area data frame are described in the following
list:

Layers

What layers represent

Houses

Locations of residences

City Buildings

Public buildings and businesses in
Angelus Oaks

Landmarks

Locations of major recreational
items in Angelus Oaks, including
picnic areas, trailheads, and
viewing points

Residential Streets

Locations of roads in Angelus
Oaks residential areas

California Mountain
Peaks

Locations of California mountain
peaks in the area

Roads, Trails, and
Creeks

Locations of major highways,
trails, and creeks

Lakes

Locations of major lakes in
Angelus Oaks

California

State of California outline

Angelus Oaks

Angelus Oaks mosaicked raster

The map portrays Angelus Oaks and the surrounding
region. Notice that there are check boxes next to each layer
name in the table of contents (except Angelus Oaks). All
layers that are checked are drawn in the map display area.
Notice that the check box next to the Houses layer is
unavailable, and a small scale bar appears underneath the
check box. This is because there is a visible scale range set
for that layer. In this case, the Houses layer will only
display when you are zoomed in close to the residential
area.
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Moving around a map
The Data toolbar has tools to move around the map and
query features on the map. Point to each icon, without
clicking, to see the name of each tool displayed in a
ToolTip. This tutorial will use these names to refer to
specific buttons and tools. When you interact with the map,
one of these tools will be active, and the pointer will
change to the active tool when moved over the map.

1. Click the Zoom In tool, then click and drag a box
around the Angelus Oaks residential area. (The
residential area is outlined in dark red on your map.)
Notice that the houses are now visible on the map and the
Houses layer check box is no longer unavailable.

1

Data toolbar

If you need more information about how a tool or
command works, you can quickly access the contextsensitive help that is available for most tools and menu
items. Press Shift + F1 on your keyboard while pointing to
the tool or highlighted item on a drop-down menu, and
information will appear, if available.

2. Using the Pan tool, you can interactively manipulate the
map. Click the Pan tool, then click the map and hold
down the left mouse button to drag the display in any
direction.
3. The Go Back and Go Next buttons can be used to revisit
places to which you have previously zoomed. Click the
Go Back button now to view the previous map extent.
Pan

Context-sensitive help for the Zoom In tool

4. Click View, point to Bookmarks, and click Angelus
Oaks Recreation Area: Angelus Oaks to reset the map to
its original extent.
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Turning layers on and off
The table of contents is where you turn map layers on and
off. To display a layer, check the check box next to the
layer’s name. To turn the layer off, uncheck the box. It is
important to remember that layers will draw on the map in
the order they appear in the table of contents. In the
Angelus Oaks example, the Houses layer will draw on top
of all other layers, while the Angelus Oaks layer will draw
beneath all other layers.
1. Click the plus sign next to the Roads, Trails, and Creeks
layer to see the symbols for each feature in the layer.

2. Uncheck the Roads, Trails, and Creeks layer under the
Angelus Oaks Recreation Area data frame. Notice that
the layer disappears from the map. Now check the
Roads, Trails, and Creeks layer. Notice that the layer
now draws on the map.
Obtaining information about layers
Each of the layers in a map has a set of properties that can
be viewed, allowing you to learn the functionality available
for that layer.
1. In the table of contents, right-click Roads, Trails, and
Creeks and click Properties.

1

1
2. Click the General tab.
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Here, you can see whether the Roads, Trails, and Creeks
layer will be displayed at all scales or only within a
specific range of scales. You can also see whether MapTips
have been enabled for the layer and which field has been
chosen to be displayed in the MapTips. MapTips are onscreen descriptions of map features that appear when you
point to a feature. Later in this tutorial you will use
MapTips from this layer.
3. Click OK to close the Layer Properties dialog box.

2

3

6

&KB$QJHOXV2DNVSPG

USING ARCREADER

$0

Using the Magnifier Window
There are times when you may not want to change the
location displayed on the map but still need to see more
detail. The ArcReader Magnifier Window allows you to do
this.
1. Click Window and click Magnifier.
The Magnifier Window opens.

2. Click the title bar of the Magnifier Window and drag it
over the map. While you are dragging it, the Magnifier
Window will show crosshairs to indicate which part of
the display will be magnified.

2

You can change several properties of the Magnifier
Window, such as the magnification factor and what the
Magnifier Window displays.
4. Move your pointer near the edge of the Magnifier
Window until it turns into resizing arrows, then click
and drag the window in the direction you want to resize
(make it a little larger).

1

While
dragging

3. When the crosshairs are over the portion of the map you
would like to magnify, release the mouse button. You
will see an enlarged view of the location under the
Magnifier Window.

5. Place your pointer inside the Magnifier Window and
right-click. Point to Magnification Factor and click
800%.

3
5

This will scale the data displayed in the Magnifier Window
by the percentage chosen.

Result after
dropping

6. Right-click the Magnifier Window and click Lock
Magnifier. Click and drag the title bar of the Magnifier
Window to move it somewhere else; notice that the
picture doesn’t change but instead keeps your snapshot.
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7. To reenable the magnifier, right-click the Magnifier
Window and click Lock Magnifier again. The window
redraws to magnify the section of the map it is over.
When you have finished experimenting with the
Magnifier Window, click the Close button.
Data view and layout view
ArcReader can display a map in either data view or layout
view. Up to this point, this tutorial has been using data
view. Data view shows the contents of a data frame. Layout
view shows the map as it would appear on a printed page.
Layout view also shows map elements that aren’t contained
within the data frame, such as the map title, legend, scale
bar, and north arrow.

display: the United States, California, and Angelus Oaks.
These inset maps are created using the three additional data
frames mentioned at the beginning of this exercise. For the
exercises in this tutorial, you will continue to use only the
Angelus Oaks Recreation Area data frame. The additional
data frames are only used for this particular layout.
In layout view, the Layout toolbar is displayed, which
contains tools for navigating in layout view. Point to each
icon, without clicking, to see the name of each tool.
The layout tools in the Layout toolbar are similar to the
tools in the Data toolbar. They allow you to change the way
the page is displayed. Notice that the data tools are still
accessible for changing the view of the data within the data
frame.

1. Click the View menu, point to Bookmarks, and click
Angelus Oaks Recreation Area: Area of Layout.

Page for map

Layout toolbar

2. Click the View menu and click Layout View.

2

The map displays in layout view. Notice the page includes
a title, legend, scale bars, and some supporting text. In this
layout, you will see three inset maps on the left side of the

Data view

Layout view
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There are shortcuts for switching between data and layout
view. On the scroll bar at the bottom of the map, there are
three small buttons. Clicking the globe icon switches to
data view, clicking the page icon switches to layout view,
and clicking the arrow icon refreshes the map.
In this exercise, you learned various ways to view a
published map in ArcReader. In the next exercise, you will
learn how to query a map in ArcReader.
3. If you are continuing to the next exercise, leave the
Angelus Oaks Recreation map open; otherwise, close it
and exit ArcReader.

ARCREADER QUICK-START TUTORIAL

&KB$QJHOXV2DNVSPG

9

$0

A map in ArcReader typically contains more information
than you initially see. For example, a feature may hold
attribute information that is not labeled or displayed on the
map. With ArcReader, you can query that information or
use MapTips to find a feature on the map.

3. Click any tool on the Data toolbar and point to a road,
trail, or creek to see its name.
The Roads, Trails, and Creeks layer is the only layer in this
map that has MapTips enabled. You can tell if MapTips are
enabled for a layer by right-clicking the layer name in the
table of contents and clicking Properties, then clicking the
General tab.

Using MapTips

Identifying a location

The most readily accessible kind of map attribute
information comes in the form of MapTips. MapTips
contain an attribute chosen by the map author that displays
whenever you rest any data tool over a feature on the map.
MapTips are only visible while in data view.

You can use the Identify tool to obtain spatial and tabular
information. You can see which features are at a specific
location and also investigate the attributes of each feature.

Exercise 2: Querying a map

1. If you closed your map document from Exercise 1, start
ArcReader and open the Angelus Oaks Recreation.pmf
for this exercise.
2. Click the Data View button
located at the bottom
left part of the map. If the Data View button is not
visible, turn on the scroll bars by clicking View, then
clicking Scroll bars.

1. Click the View menu, click Bookmarks, then click
Angelus Oaks Recreation: City Buildings.
2. Click the Identify tool.
The Identify dialog box opens.

2
3. Click the Identify from drop-down list and click
<Visible layers>.

3

Road name
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4. Click the building that represents the Visitor Center.

4

Identify dialog box commands
Right-clicking features, layers, or their attributes in the
Identify dialog box opens a context menu with options for
working with the fields for that feature or layer.
1. Right-click a layer or feature on the left side of the
Identify dialog box. The options in the context menu
allow you to zoom to features, center features, expand
all the layers and features, collapse the Identify tree,
remove from the Identify tree, sort the layers and
features, or copy a record.

1

Information for the Visitor Center and other visible layers are
displayed in the Identify dialog box.
Layer

Feature

Location

Attributes

2. Right-click an item in the Value column on the right side
of the window. The options in the context menu allow
you to organize the displayed attribute information. You
can hide or show all the fields, sort fields, select all the
fields, switch the set of selected fields, or copy all the
fields. If you click Copy, you can then paste the
information into another application, such as a text
editor or a spreadsheet.
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Finding a location

2

In ArcReader, it is easy to find a feature based on a name or
value using the Find tool.
1. Click the Find tool.
The Find dialog box appears.

1
3. Click the small drop-down button to the right of the
Location text box to open a menu that will allow you to
display the location of the city in the units of your
choice. Click Meters.

3

2. In the Find text box, type “San Bernardino”.
3. Click the In layers drop-down arrow and click
<All layers>.
4. Click Find. ArcReader locates all the items contained in
the map named San Bernardino and shows them as rows
in the Results section of the window.

2

3

4

4. Click Visitor Center underneath City Buildings. Click
Lodge.jpg in the attribute columns. A hyperlinked
picture of the Visitor Center, which resembles a lodge,
will appear.
You’ll learn more about hyperlinks later in this tutorial.
5. Close the Identify dialog box.

12
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Once you’ve found a place, you can use the Find dialog
box to navigate to or learn more about the feature.
5. In the Find dialog box, right-click San Bernardino
Trailhead, and click Zoom to Feature(s). ArcReader
zooms to the trailhead for the San Bernardino Peak trail.

videos, and Web pages. As you saw in the previous lesson
about identifying features, hyperlinks can be accessed
through the Identify dialog box. Hyperlinks can also be
accessed directly on the map document. The Angelus Oaks
Recreation map contains additional hyperlinks in the City
Buildings and Landmarks layers. You will need an Internet
connection for the hyperlinks in this exercise. If you do not
have an Internet connection, skip step 4 of this exercise.
1. Click the View menu, point to Bookmarks, click
Angelus Oaks Recreation Area: Viewpoint and
Trailhead, then continue with the exercise.
2. Verify that the Landmarks layer has been checked on,
and click the Hyperlink tool on the Data toolbar to
activate it.

5

5

7

6

Results section of Find
dialog box

6. Make sure the Find dialog box does not cover the San
Bernardino Peak Trailhead. In the Find dialog box,
right-click San Bernardino Trailhead and click Flash
Feature(s). The trailhead will flash.
7. Right-click San Bernardino Trailhead and click Identify
Feature(s). The Identify dialog box, which contains all
the attribute information for the San Bernardino Peak
Trailhead, appears.

2
Notice that a blue dot appears over the icons for both the
San Bernardino Peak Trailhead in the upper right corner
and the Viewpoint in the lower left corner. These blue dots
indicate hyperlinked features.
San
Bernardino
Peak
Trailhead

8. Close the Identify and Find dialog boxes.
Using hyperlinks
Maps viewed with ArcReader may have hyperlinks to
provide additional information about certain features.
Hyperlinks allow you to provide additional information
about features by linking to items, such as documents,

Viewpoint
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3. Point the Hyperlink tool at the center of the blue dot
hyperlink for the Viewpoint shown in the bottom left
corner. The pointer changes to a pointing hand. Click to
open a picture of the view from this viewpoint.
4. Point the Hyperlink tool at the center of the blue dot
hyperlink for the San Bernardino Peak Trailhead. The
pointer changes to a pointing hand. Click to open your
default Internet browser. The official Web site of the
United States Forest Service, San Bernardino, where
you can learn more about the San Bernardino National
forest, displays.

4
5. Double-click the campsite to finish measuring.
The line you drew disappears.

Measuring distance
You can measure distances and areas in ArcReader. The
ArcReader Measure tool allows you to see how far apart
two places are, plot a route and check the distance, or
measure the area of an object.
1. Click the View menu, point to Bookmarks, then click
Angelus Oaks Recreation Area: Mountain Home Flats
Trail.
2. Click Tools, click Options, and click the 2D Data View
tab. Uncheck MapTips so they do not appear when you
are measuring features in the region.

There are a few things to notice as you do this. Attached to
the pointer you will see a box that contains the current
segment’s length. Second, you will see the total distance
you have measured, approximately 2,509 meters.
6. Click the View menu, point to Bookmarks, then click
Angelus Oaks Recreation Area: Shadow Lake.
7. Click the Measure tool on the Data toolbar.
8. Hold down the Alt key, then click a path following the
perimeter of Shadow Lake. In addition to seeing the
segment distance and total distance, the area will now
be listed in the box attached to the pointer.

3. Click the Measure tool on the Data toolbar.

Measure tool

8

4. Click the Mountain Home Flats Trailhead on the left
side of the map, then trace along the trail to the campsite
by clicking each time you want to change directions.
14
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Using the Swipe tool
It is often useful to see how certain layers overlay other
layers. The Swipe tool in ArcReader allows you to see the
layers underneath a particular layer without turning it off in
the table of contents. Before beginning this exercise, make
sure you are in data view.
1. Click View, point to Bookmarks, and click Angelus
Oaks Recreation: Angelus Oaks.
2. In the Angelus Oaks Recreation Area data frame, turn
off the California layer (uncheck the box) and turn on
the Angelus Oaks layer (check the box), to reveal the
Angelus Oaks image layer.
3. Click the Swipe button on the Data toolbar.

5. Position the pointer at the top of the Angelus Oaks
picture. Click and drag the mouse down to the bottom of
the data frame. The pointer will change to a double
arrow, and the Roads, Trails, and Creeks layer will
disappear when the mouse is dragged up, down, left, or
right to reveal the Angelus Oaks raster layer beneath.
6. If you are continuing to the next exercise, leave the
Angelus Oaks Recreation map open; otherwise, close it
and exit ArcReader.
In this exercise, you have used the tools in ArcReader to
perform queries on the Angelus Oaks Recreation Area map.
The next exercise will show you how to print from
ArcReader.

A drop-down list of the layers in the data frame appears.
4. Double-click Roads, Trails, and Creeks. This will be the
layer that is swiped over the rest of the layers.

3

4

A layer can be swiped vertically or horizontally. When you
position the Swipe tool over the map, the pointer will turn
into an arrow that points in the direction that you can swipe
the layer.
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Exercise 3: Printing a map
To perform the following exercise, you will need to have a
printer available. The printer should be able to print a letter
size (or A4) sheet of paper and can be either a black-andwhite or color printer.
1. Click the ArcReader File menu and click Page Setup.
The Page Setup dialog box opens. This dialog box contains
options that allow you to change which printer you are
using or the settings for that printer.

3. Click Landscape.
4. In the Printer Setup box, click the Size dropdown arrow
and click Letter (or A4).
Note that it is possible to print this map to a larger or
smaller paper size by checking the Scale to fit Page check
box in the Page Setup dialog box. The map will scale up or
down to fit the page.
5. Click OK.

1

4

3
2. If the printer you want to print from is set as your
default printer, skip to step 3. Otherwise, click the
Printer drop-down arrow and choose the printer to
which you want to print your map.
16
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Printing a map

2. Click the File menu and click Print.

1. Click the Layout View button at the bottom of the map
page.
It’s important to switch to layout view because the region
that is printed can vary depending on which view you are
in. Printing in data view will print the currently displayed
data frame at the current extent to the selected paper size.
The printed data will be scaled to fit the page size you
chose in the Page Setup dialog box. When printing from
layout view, however, the entire published page is printed.
In addition, you will not have the map elements, for
example, north arrow and scale bar, if you print from data
view instead of layout view.

3. Click OK.
In Layout view the original page size
is displayed on the status bar.

4. Close the Angelus Oaks Recreation.pmf.
In the previous exercises in this tutorial, you were
introduced to viewing, querying, and printing 2D published
maps with ArcReader. In the next exercise, you will be
introduced to viewing 3D maps in ArcReader.
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Exercise 4: Exploring a 3D map
In this exercise, you will open and explore a 3D map
published from ArcGlobe that contains 3D views and
features. With 3D .pmfs, you are still able to find, measure,
identify, use hyperlinks, and swipe layers as you did in the
previous exercises with the 2D map. In addition, the 3D
globe environment allows for rotating the globe in many
directions and flying through various geographic locations.

1. Click the Find tool to open the Find Dialog box.
2. Click the ArcWeb Place Finder tab.
3. In the Find place text box, type “Angelus Oaks” and
click Find. ArcWeb Place Finder finds Angelus Oaks,
California, United States.
4. Right-click Angelus Oaks in the Find dialog box, and
click Zoom to place. ArcReader zooms to Angelus Oaks.
5. Close the Find dialog box.

Starting ArcReader and opening a 3D .pmf
1. Start ArcReader and navigate to your local drive where
your tutorial data is stored.
2. Click AngelusOaks3D.pmf and click Open.
The AngelusOaks3D.pmf opens with a full extent view of
the globe. Notice that the Data toolbar is the same as with a
2D .pmf. In addition, there is a new Globe toolbar with
tools specifically designed for interacting with 3D maps.
The Globe toolbar will be discussed in a future lesson.

2
3

Using the ArcWeb Place Finder
The ArcWeb Place Finder enables you to look up places by
name and navigate to them in the map. In ArcReader,
ArcWeb Place Finder capabilities are available as an
additional tab in the Find dialog box. You can search by
name; specify the category of locations to search, such as
airports or small cities; and decide the number of matching
results to return.
Note: An Internet connection is required for the following
steps. If you do not have an Internet connection, skip to the
next lesson, The Globe toolbar.

4

You are now looking at the Angelus Oaks area from
directly overhead.
In the next sections, you will use the global navigation
tools to change your point of view, move the globe in

18
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with the Target tool allows you to zoom in and center at a
location.

Globe
Navigation

Orbital
Fly

Globe toolbar

Pivot

View of Angelus Oaks from directly overhead

different directions, and fly through the Angelus Oaks area
you explored in the 2D exercises.
The Globe toolbar
The Globe toolbar has been introduced into ArcReader to
enable viewing and navigating 3D globes published from
ArcGlobe.
1. Rest the mouse pointer over each tool in the Globe
toolbar to see the ToolTip for each.
There are four tools on the Globe toolbar: Globe
Navigation, Pivot, Orbital Fly, and Target. In addition,
right-clicking the map display with the Globe Navigation,
Pivot, or Orbital Fly tools allows you to zoom in and out
without having to change tools. Right-clicking the display

The following steps will show you how to use the Globe
Navigation, Pivot, and Target tools. You will use the
Orbital Fly tool in the next lesson.
1. Click the Full Extent button to reset the Globe to the
original display. Here you will explore the Globe
Navigation tool.
2. Click the Globe Navigation tool and click and drag on
thedisplay area to move the globe up, down, and to each
side.
3. Click View, point to Bookmarks, and click View from
North. You are now looking out over Angelus Oaks from
the North. Here you will explore the Target and Pivot
tools
4. Place a check in the box next to the following layers to
turn them on: Landmarks, Houses, City Buildings,
California Mountain Peaks, Road, Trails and Creeks,
Residential Streets, and Lakes.

ARCREADER QUICK-START TUTORIAL

&KB$QJHOXV2DNVSPG

Target

19

$0

5. Click the Target tool and click Shadow Lake (shown in
blue on the right side of the map display). The lake is
now in the center of the display.

7. Click the Pivot tool, then click and drag on the display
to see a 360-degree view of the area around the lake.
When the Pivot tool is clicked, the object at the center
of the display will become the pivot point of the map.
With any of the Globe tools active, you can either roll the
mouse wheel or right-click and drag to zoom in and out.
Additional bookmarks are provided in this document. You
can use them to explore the region or reset the display after
using the Globe toolbar tools.

Lake

View of Angelus Oaks from the north

6. With the Target tool still active, right-click the lake. You
will zoom to the lake and also see 3D symbols for
houses in the area and a picnic area at the lake.

Navigating the globe with the Orbital Fly panel
When you click the Orbital Fly tool to begin flying, the
Orbital Fly panel will appear. From the Orbital Fly panel
you can control altitude, pitch, and flying direction and
speed. The Orbital Fly tool looks down from an orbiting
object, whereas the existing Fly tool in ArcGlobe gives you
the forward-looking view from a flying object.
Flying can be accomplished using the Orbital Fly panel,
mouse, keyboard, or a combination of these.
1. Click Tools and click Options. Click the 3D Data View
tab. This tab allows you to control globe display settings
and level of detail settings.
2. Check Stop navigation at globe surface and Show North
Arrow.
3. Click OK to close the Options dialog box.
4. Click the Orbital Fly button. The Orbital Fly panel
appears.

Shadow Lake and surrounding residences
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1
Hide Panel
Fixed Line
of Sight

2

Keyboard
Shortcuts

Altitude Pitch
Control Control

Flying
Controls

There are also three buttons on the right side of the Orbital
Fly panel: Hide Panel, Fixed Line of Sight, and Keyboard
Shortcuts. Clicking the Hide Panel tool will minimize the
dialog box to the title bar while you are flying. Clicking the
Fixed Line of Sight button will keep a particular target in
the line of sight when flying. Clicking the Keyboard
Shortcuts button will show all the keyboard shortcuts for
flying.
From the Orbital Fly panel, you can start and stop flying,
fly in any direction, adjust flying speed, and change
altitude and pitch. The up arrow on the Orbital Fly panel
will increase forward flying speed. Alternately, the down
arrow will reduce speed and begin flying backward. The
other arrows will shift the position of the earth as you fly
over it either up left, up right, down left, or down right.

The Fixed Line of Sight button can be used to control how
the observer positions itself in relation to the globe while
flying. If the Fixed Line of Sight is turned on, the observer
will zoom in and out along the line of sight when the
altitude is adjusted. If the Fixed Line of Sight is off, the
observer will increase or decrease vertically in relation to
the globe surface.
5. Click View, point to Bookmarks, and click View North
from Peak. You should now be looking toward the
residential area of Angelus Oaks from the top of
Constance Peak.
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can be used in conjuction with the mouse to improve the
smoothness of the flying experience.
1. Click View, point to Bookmarks, and click View North
from Peak.
2. If necessary, click the Orbital Fly tool to ensure that it is
active. The Orbital Fly panel will appear, but this time
you will use the mouse to start, stop, and direct flying.
3. Click anywhere on the display with the mouse to begin
flying.
As you move the mouse up and down in the middle of the
display, you will increase your forward and backward
flying speeds. As you move the mouse to the left or right,
you will change the direction in which you fly.
View north from peak

6. Click the Play button on the Orbital Fly panel to begin
flying. Experiment with adjusting the altitude and pitch.

4. Click again to stop flying, or press the Esc key to end
flying.
5. Click the Keyboard button on the Orbital Fly panel to
display the keyboard shortcuts for flying.

7. Click the Stop button to end flying.
Continue to experiment with the Orbital Fly panel tools by
navigating around the Angelus Oaks area, and resetting the
display using the bookmarks when necessary.
Navigating the globe with the mouse and
keyboard
The following lesson will show you how to use the mouse
and keyboard instead of the buttons on the Orbital Fly
panel. With the mouse, you can control speed and
direction, although items such as altitude and pitch still
have to be controlled with the Orbital Fly panel. The
keyboard contains shortcuts for all flying capabilities and

Keyboard Shortcuts
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Notice that you can control the direction of flying with
either the directional arrows on your keyboard, or the W,
A, S, and D keys. You control the Altitude with the L and J
keys, the Pitch with the I and K keys, and the Roll with the
N and M keys.
6. Click the Play button on the Orbital Fly panel to begin
flying.
7. Use either the directional arrows or the W, A, S, and D
keys to control the direction of flight.
8. Press the Altitude up and down keys (L and J) to change
altitude while flying.
9. Press the Pitch up and down keys (I and K) to change
the pitch while flying.
10.Finally, press the Roll left and right keys (N and M) to
roll the globe to the left or right while flying.
11.Click the Stop button on the Orbital Fly panel to stop
flying.

Viewing an animation
Animations make a 3D document come alive by storing
actions so they can be replayed. They can help you
visualize changes, such as perspective and geographical
movements. Animations are created in ArcGlobe by the
map publisher.
1. Click View and click Animations.
The Animation control panel will appear. Animations the
publisher has saved with the map will be displayed in a
drop-down list on the control panel.
The animation flys you to the Angelus Oaks area that you
viewed as a 2D map in exercise 2 of this tutorial. The
animation may need to be run several times to improve the
overall smoothness with which it displays.
2. Click the drop-down list, click AngelusOaks3D, and
click the Play button.

2

12.Close the Orbital Fly panel.
You will notice that the Forward and Backward flying keys
will increase and decrease speed similarly to the forward
and backward buttons on the Orbital Fly panel.
Once you are familiar with many of the keyboard shortcuts
to flying, it is often easiest to use the keyboard and the
mouse together to fly. For instance, you can begin flight
and control the direction of flight with the mouse while
controlling the altitude, pitch, and roll with the keyboard.

Animation control panel

3. Place a check in the box next to the following layers to
turn them on: Landmarks, Houses, City Buildings,
California Mountain Peaks, Road, Trails and Creeks,
Residential Streets, and Lakes.
4. Close the Animation control panel when you are
finished.
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These lessons provided an overview of the various
functionality available in ArcReader for viewing 3D
globes. Additional information can be found in the
ArcReader Desktop Online Help and the ArcReader
product page located at www.esri.com/ArcReader.
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